Chapter 1. Introducing ArcGIS

Mastering the Concepts

Objectives
- Understanding the architecture of the ArcGIS program
- Becoming familiar with the types of data files used in ArcGIS
- Learning how to explore data files using ArcCatalog

Concepts

Storing map data

To work with maps on a computer requires developing methods to store different types of map data and the information associated with it. Objects in the real world such as cities, roads, soils, rivers, and topography must be portrayed as map objects, such as those on a paper topographic map. Then these map objects must be encoded for storage on a computer.

Many different data formats have been invented to encode data for use with GIS programs: however, most follow one of two basic approaches: the vector model or the raster model. In either approach, the critical task includes representing the information at a point in space using $x$ and $y$ coordinate values (and sometimes $z$ for height). The $x$ and $y$ coordinates are the spatial data. The information being represented, such as a soil type or a chemical analysis of a well, is called the attribute data. Raster and vector data models both store spatial and attribute data, but they do it in different ways.

Both data systems are georeferenced, meaning that the information is tied to a specific location on the earth’s surface. One can use a variety of different coordinate systems for georeferencing, as we will see in Chapter 3. As long as the coordinate systems match we can display any two spatial data sets together and have them appear in the correct spatial relationship to one another.

The vector model

Vector data uses a series of $x$-$y$ locations to store information. Three basic vector objects exist: points, lines, and polygons. These objects are called features. Point features are used to represent objects that have no dimensions, such as a well, or a sampling locality. Line features represent objects in one dimension, such as a road or a utility line. Polygons are used to represent areas, such as a parcel or a state.

In all cases, the features are represented using one or more $x$-$y$ coordinate locations (Fig. 1.1). A point consists of a single $x$-$y$ coordinate. A

![Fig. 1.1. The vector data model uses a series of $x$-$y$ locations to represent points, lines, and polygon areas.](image-url)
line includes two or more coordinates—the endpoints of the line are termed nodes and each of the intermediate points is called a vertex. A polygon is a group of vertices that define a closed area.

To some extent, the type of object used to represent features depends on the scale of the map. A large river would most likely be represented as a line on a map of the United States, because at that scale it is too small for its width to encompass any significant area on the map. If one is viewing a USGS topographic map, however, the river can encompass a larger area and might be represented as a polygon.

In the GIS view of the world, like features are grouped into data sets called feature classes (Fig. 1.2). Roads and rivers are different types of objects and would be stored in separate feature classes. A feature class can only contain one kind of geometry—it can include point features, or line features, or polygon features, but never a combination. In addition, objects in feature classes share a table containing their attributes, and so must have like attributes. A river and a highway would not be found in the same feature class because their attributes are different. The pavement type would not be a logical attribute for a river.

Each feature in a vector file has information about it; these are its attributes. The attributes are stored in a table, with a unique feature identification code (FID) linking the feature with its attributes (Fig. 1.3). Each feature corresponds to one and only one line (record) in the table. The attributes for a state might include its name, abbreviation, and population. When a state is highlighted on the map, its record in the table is also highlighted, and vice versa. It is this live link between the spatial and attribute information that gives the GIS system its power. It enables us, for example, to create a map in which the states are colored based on their populations (Fig. 1.2). This thematic mapping is only one example of how linked attributes can be used to analyze geographic information.

Feature classes can be stored in several different formats. Some data formats, such as shapefiles, only contain one feature class. Others, such as coverages and feature datasets in geodatabases, can contain multiple feature classes that are in some way related to each other. For example, a feature dataset called Transportation in a geodatabase might contain the feature classes Roads, Traffic Lights, Railroads, and Canals.

Two basic vector models exist, topological models and spaghetti models. A spaghetti model simply stores features of the file as independent objects, unrelated to each other. A topological data model also stores information about how the features are spatially related, such as whether they are adjacent or connected. ArcGIS uses both kinds of models. A roads shapefile is a
spaghetti model; features are stored as simple strings of x-y coordinates. A Transportation feature dataset in a geodatabase may contain topological rules for its feature classes, such as that roads must always connect to other roads, or that a traffic light may only occur at a road intersection.

The benefits of the vector data model are many. First, it can store individual features such as roads and parcels with a high degree of precision. Second, the linked attribute table provides great flexibility in the number and type of attributes which can be stored about each feature. Third, the vector model is ideally suited to mapmaking because of the high precision and detail of features which can be obtained. The vector model is also a compact way of storing data, typically requiring a tenth of the space of a raster with similar information. Projection of vectors from one coordinate system to another is faster, so much so that only recent versions of GIS have supported on-the-fly raster projection. Finally, the vector model is ideally suited to certain types of analysis problems, such as determining perimeters and areas, detecting adjacency of features, and modeling flow through networks.

However, the vector model has some drawbacks. First, it is poorly adapted to storing continuously varying surfaces such as elevation or precipitation. Contour lines (as on topographic maps) have been used for many years to display surfaces, but calculating derived information from contours, such as slope, flow direction, and aspect, is difficult. Finally, some types of analysis are more time-consuming to perform with vectors.

The raster model

The raster model has the benefit of simplicity. A set of spatial data, such as a land use map, is represented as a series of small squares, called cells or pixels (Fig. 1.4). Each pixel has a numeric code indicating the land use, and the raster is stored as an array of numbers. To display it, a different color is assigned to each code value.

![Raster data file](image)

Fig. 1.4. The raster data model uses an array of values to represent a map. The raster is tied to a real-world location using the x-y coordinates of the upper left corner.

A raster data set is laid out as a series of rows and columns. Each pixel has an “address” indicated by its position in the array, such as row = 3 and column = 6. Georeferencing a map in an x-y coordinate system requires four numbers: an x-y location for one pixel in the raster data.
set, and the size of the pixel in the x and y directions. Usually the upper-left corner is chosen as the known location, and the x and y pixel dimensions are the same, so that the pixels are square. From these four numbers, it is possible to calculate the coordinates of every other pixel based on its row and column position. In this sense, the georeferencing of the pixels in a raster data set is implicit—one need not store the x-y location of every pixel.

The x and y dimensions of each pixel define the resolution of the raster data. The higher the resolution, the more precisely the data can be represented. Consider the 90-meter resolution roads raster in Figure 1.5. The three colors represent three different numeric values indicating primary, secondary, and primitive roads. Since the raster cell dimensions are 90 meters, the roads are represented as much wider than they actually are, and they appear blocky rather than forming smooth curves. A 10-meter resolution raster could represent the roads more accurately; however, the file size would increase by $9 \times 9$, or 81 times.

![Discrete rasters: Roads](image)

Fig. 1.5. Discrete rasters store categorical data such as land use or road types. Continuous rasters store data which vary smoothly over a surface, such as a digital elevation model (DEM) or rainfall.

Two styles of raster data can be stored (Fig. 1.5). A discrete raster has relatively few possible values that tend to repeat themselves in adjacent cells. Categorical data, which falls into a few named categories, is typically discrete also. Roads are discrete, with a value representing the location of the road segment and its type. Land use is both categorical and discrete, with relatively large patches of adjacent cells sharing the same land use code. The codes are drawn from a list of defined values. When a land use boundary is crossed, the code changes abruptly to a new one with no intermediate values. A continuous raster data set is one with a large selection of numeric values that can range smoothly from one location to another. A digital elevation model (DEM) is an example of continuous data—cells are unlikely to have the same elevation value as their neighbors. Satellite images and other remotely sensed data such as digital air photos or thermal imagery are other sources of continuous raster data. Different strategies are used to display discrete versus categorical data.

The raster model mitigates some of the drawbacks of vectors. It is ideally suited to storing continuous and rapidly changing discontinuous information, because each cell can have a value completely different from its neighbors. Many analyses are simple and rapid to perform, and an
extensive set of analysis tools for rasters far outstrips those available for vectors. One benefit of rasters is access to an analysis method called map algebra, in which maps can be used as part of algebraic expressions.

The drawbacks of rasters lie chiefly in two areas. First, they suffer from trade-offs between precision and storage space to a greater extent than vectors do. The second major drawback of rasters concerns their ability to store attributes. A raster file is an array of cells with numeric values, and each cell has only one value. To store both geology and infiltration values for an area requires storing two separate rasters. Vector files, by contrast, can store hundreds of attribute values for each spatial feature, and can handle text data more efficiently.

**ArcGIS overview**

ArcGIS is developed and sold by Environmental Systems Research Institute, Inc. (ESRI). It has a long history and has been through many versions and changes. Originally developed for large mainframe computers, in the last 10 years it has metamorphosed from a system based on typed commands to a full-featured graphical user interface (GUI), which makes it much easier to use. Because of the size and complexity of the program (actually a suite of programs), and because users have come to depend on certain aspects of the software, much of the code is carried forward and included in the new versions. Knowing this background helps a student of ArcGIS understand the nature of the ArcGIS system, and helps explain some of its odd features and characteristics.

For example, the software originally used sets of files called coverages to store the geographic data. These files were developed using a database called INFO, which was state-of-the-art at the time, but appears primitive today. ESRI has now developed a new data model, the geodatabase, based on current database technology and with exciting new features. However, rewriting the millions of lines of code developed to process and to analyze coverages takes time. Thus today the current version of ArcGIS can use both the old and new data models; however, some important functions are only available for the old coverages. Other functions only operate on the new type of files. Thus for the time being, one must understand and be able to work with both the old and the new.

The older core of the ArcGIS system was called Arc/Info and included a basic set of programs: Arc, ArcEdit, and ArcPlot (Fig. 1.6), which utilized the coverage data model. Also included was a version of the INFO database system called Tables, and a programming language called Arc Macro Language, or AML. Optional programs could also be purchased to extend the

![Fig. 1.6. Relationship between ESRI products and data formats](image-url)
functionality, including GRID, TIN, and COGO. All of these programs were command based, meaning that the user typed commands into a window to make the program work.

The difficulty of learning Arc/Info prompted ESRI to create a piece of software called ArcView, which was based on a GUI and designed to be easy to use. However, it was not as powerful as Arc/Info. ArcView was designed primarily to view and analyze spatial data, rather than create it. ArcView also used a simpler data model, called the shapefile, although it could read coverages and convert them to shapefiles. Beginners in GIS often learned ArcView first, and then began learning Arc/Info as their needs and abilities advanced. Advanced Arc/Info users, however, would use ArcView when they could, because it was so much easier to use, especially for creating maps.

ArcGIS, released in 2001, is a synthesis of the powerful Arc/Info system with the easy-to-use interface of ArcView, updated to use the latest advances in desktop computing and database technology. It contains two programs, collectively referred to as ArcGIS Desktop (Fig. 1.7).

- **ArcMap** provides the means to display, analyze, and edit spatial data and data tables. Similar in appearance to its ArcView predecessor, it nevertheless contains powerful new functionality.

- **ArcCatalog** is a tool for viewing and managing spatial data files. It resembles Microsoft Windows Explorer, but it is specially designed to work with GIS data. It should *always* be used to delete, copy, rename, or move spatial data files.

![ArcMap and ArcCatalog](image)

*Fig. 1.7. The core programs of ArcGIS Desktop*

In addition, ArcGIS Desktop contains **ArcToolbox**, a collection of tools and functions that work in ArcCatalog and ArcMap, such as converting between data formats, managing map projections, and performing analysis. Users may create and add their own tools or scripts for special or often-used tasks. The ESRI website at [www.esri.com](http://www.esri.com) has a large library of scripts and tools that can be downloaded to extend the ArcGIS functionality.
Finally, the original Arc/Info command-line software can still be accessed in the additional module called **Workstation Arc**, which is still used by many organizations that may be tied to the older coverage model for various reasons, such as having a large number of specialized programs written in the older AML programming language.

The ArcGIS system also provides different levels of functionality that all use the same basic interface. Users can save money by buying only the functions they need. These levels include the following:

- **ArcView** provides all of the basic mapping, editing, and analysis functions for shapefiles and geodatabases and is the level of functionality most users will require on a regular basis. It includes ArcMap and ArcCatalog, and a subset of ArcToolbox functions.

- **ArcEditor** includes all the functions of ArcView but adds editing capabilities needed to work with the advanced aspects of the geodatabase, such as topology and network editing. Additional functions reside in ArcToolbox with this level.

- **ArcInfo** provides access to the full functionality of the ArcGIS Desktop tools, and the full version of ArcToolbox. In addition, it includes the original core Arc/Info software, now called Workstation Arc.

This book focuses almost exclusively on the functions available with an ArcView license, although it mentions some of the additional capabilities as appropriate. Users can read the software documentation to learn more about the advanced topics.

The ESRI system of GIS programs, then, is a fairly complex set of tools with a long history, designed to work with a number of different data formats, also with a long history. We turn now to a discussion of how spatial and aspatial data are stored in the computer.

**Data files in ArcGIS**

ArcGIS can read a variety of different file formats. As indicated before, many of these come from older versions of the software. Some can come from other programs such as image processing packages and Computer Aided Design (CAD) systems. Each of these file formats is described in some detail in the paragraphs that follow. The icon illustrations show how these data sets appear in ArcCatalog.

**Shapefiles**

Shapefiles are vector data files developed for the early version of ArcView and have been carried over into ArcGIS. They do not store topology, and they can contain only one feature class. They may contain points, lines, or polygons, and their attribute data are stored as dBase files (extension .dbf). A shapefile is actually a collection of files on the disk, with a common name but different extensions (e.g., roads.shp, roads.dbf, roads.shx). Shapefile features have green icons, with different symbols for point, line, and polygon shapefiles.

**Coverages**

A coverage is the vector data format developed for Arc/Info and is the oldest of the data formats. Coverages are topological data sets and usually contain multiple feature classes. Coverages are also composed of multiple files on the disk and even span data among multiple folders. A
coverage data set includes a folder containing several data files with an .adf (arc data file) extension. In addition, more files are stored in a folder called info that must be in the same directory. A folder containing one or more coverages is called a workspace, and it includes the info folder as well as folders for each coverage. All of the spatial and attribute information for coverages are stored in INFO format data files. Coverages have yellow icons.

Geodatabases

Geodatabases represent an entirely new model for storing spatial information that far exceeds the capabilities of coverages or shapefiles. They can contain multiple feature classes, including tables not linked with spatial data. They are stored as single database files, and they require an underlying database system to operate. They can store topological relationships between features and feature classes. They can also store rules on how the features in the geodatabase can behave and what attribute values they can have; for example, a traffic light must always be associated with a street intersection, or a telephone pole must be made of either wood or metal. These rules make it easier to model the behavior of features and reduce errors associated with data entry. Geodatabases have grey icons. Chapter 13 describes this model and its capabilities in more detail.

Two types of geodatabases are used by ArcGIS. Personal geodatabases are designed for use by individuals and are based on Microsoft Access database technology. Enterprise geodatabases are also called relational database management systems (RDBMS) and are implemented within programs such as Oracle or SQL Server. Enterprise systems are designed to meet security and management needs for large data sets accessed by multiple users. For example, at least three groups of users might need to edit parcel records in a large city database: the tax department, the city surveyors, and the deeds office. Instead of maintaining three sets of data, an RDBMS allows users to “check out” certain portions of data for editing and merges the changes back into the central database. ArcSDE is a program that allows GIS data to be stored in an RDBMS while allowing users to view and manipulate the data in ArcMap or ArcCatalog.

Database connections

Database connections permit users to log in to and utilize data from an enterprise geodatabase.

Layer files

A layer file does not contain spatial data. Instead it references a spatial data file and stores information about its properties, such as how it should be displayed. One use of a layer file is to store a set of symbols for displaying data the same way every time. For example, a city engineer could load a set of standard land use symbols from a layer file to quickly create a map, and to ensure that the same symbols are always used for each land use type. Several layers can be combined to form a group layer. Layers have yellow diamond-shaped icons and can refer to raster or vector data.

Rasters

Rasters are arrays of numbers stored in binary format (base 2). Rasters consist of the data itself plus a header that gives information about the file, such as its number of rows and columns and its georeferencing information. This information may be stored in a separate file, or as the first part of the binary raster. Many different formats of rasters exist, and ArcGIS recognizes a great many of them. Rasters can be displayed in many different ways, but they cannot be analyzed
unless they are converted to grids. A list of supported raster formats can be found in the ArcMap Help under the index heading “rasters, formats.”

### Tables

Tables can exist as separate data objects that are unassociated with a spatial data set. These are called standalone tables. They may be stored in dBase format (.dbf) or as comma-delimited text files. INFO files may also be created, stored, and accessed as standalone tables. Info table icons have a yellow strip at the top; dBase table icons have a green strip.

### Grids

A grid is a raster format developed by ESRI and used with ArcView, Arc/Info GRID, and ArcGIS software. Grids can be displayed in a variety of ways, and they can also be manipulated and analyzed by the ESRI software Spatial Analyst or Grid.

### Internet servers

Many organizations now make data available over the Internet. Users can connect to these data sources and download information for their work. To connect, you need to know the URL of the service, such as www.geographynetwork.com (Fig. 1.8).

Fig. 1.8. The Geography Network offers many types of map data to use in GIS projects.

Two types of services are offered. An **image service** allows people to display the information and print out a map from it, but they cannot change how it is displayed or make a copy of the data. A **feature service** allows people to download the data, view it, and save the features as a shapefile for later use. One of the largest Internet servers is called the Geography Network. Developed and maintained by ESRI, it offers a wide selection of information.

### TINs

TINs are Triangulated Irregular Networks that store surface information, such as elevation, using a set of nodes and triangles. TINs are used to display and analyze 3D surface information, create contour maps, and perform other functions.
**CAD drawings**

Data sets created by CAD programs can be read by ArcGIS, although they cannot be edited or analyzed unless they are converted to shapefiles or geodatabases. A CAD file may contain multiple feature classes, which correspond to the layers of the drawing, and can be opened separately and viewed just like feature classes in a coverage or a geodatabase. One can also access CAD drawings, which portray all the features in the CAD file with preset symbols. In a drawing, the feature classes are not accessible individually. CAD layers have blue icons.

**Properties of spatial data files**

**Shapefiles**

Shapefiles are among the simplest spatial data sets. A shapefile contains only one feature class: points or lines or polygons, never a mixture. Each feature is independent and unrelated to any other features. The attributes associated with each feature are stored in a dBase file. Shapefiles can, however, store multifeatures, which are single features made of multiple objects. For example, the state of Hawaii requires multiple polygons to represent each island, but it can be stored as a multifeature so that it has only one record in the attribute table.

Although a shapefile appears as one icon in ArcCatalog, it is actually composed of multiple data files, which can be seen individually in Windows Explorer (Fig. 1.9). Note that the states shapefile has eight different files associated with it. The .shp file stores the coordinate data, the .dbf file stores the attribute data, and the .shx file stores a spatial index which speeds drawing and analysis. These first three files are required for every shapefile to function properly. Additional files may also be present: the .prj file stores projection information, the .avl file is a stored legend, and the .xml file contains metadata. Similar files are present for the roads_rt shapefile. Note that to copy a shapefile to a new location all of these files must be moved together. ArcCatalog takes care of this automatically, but Windows Explorer does not.

In a shapefile attribute table, the first two columns of data are reserved for storing the feature identification code (FID) and the coordinate geometry (Shape) field. These fields are created and maintained by ArcGIS and should never be modified by the user. All other fields are added by the user and can be modified without difficulty.

Shapefiles make use of a notion called coincident geometry. Two adjacent polygons in a shapefile share a common boundary (Fig. 1.10). The boundary is stored twice, once for each
feature, yet measures can be taken to ensure that the boundary has exactly the same vertices for each polygon, so that the boundaries coincide exactly.

**Geodatabases**

A geodatabase is stored as a single file with an .mdb extension, using Microsoft Access database technology. Yet it can contain multiple feature classes, geometric networks, tables, rasters, and other objects such as rules (Fig. 1.11). Spatial data can be created as coverages or shapefiles and loaded into the geodatabase as feature classes.

Feature classes may exist as individual elements in a geodatabase (as do the restaurants or schools), or they may be grouped into **feature datasets**. A feature dataset contains a collection of related feature classes with the same coordinate system. The Utilities feature dataset in Figure 1.11 contains several feature classes related to a water network, such as waterlines and T-valves. A feature dataset can store complex associations between feature classes, such as networks or topology.

A **network** consists of interconnected features along which flow can be initialized and studied, such as water in streams, electricity through wires, or traffic on road systems. The Utilities dataset in Figure 1.11 contains a network named Water_Net constructed from its feature classes. The Water_Net and Water_Net_Junctions are additional feature classes associated with this network. Chapter 14 describes some special analysis functions that can be used with networks.

Feature datasets may also contain **planar topology**, which tracks spatial relationships within or between layers. To create topology, the user specifies rules describing the required and permitted relationships. For example, in an ideal data set, counties should not have gaps between them and should not extend even a tiny bit outside their state. Such errors are commonly introduced during the creation and editing of data; geodatabase topology assists in finding and correcting them. Editing with topology requires an ArcEditor or ArcInfo license. Simple topology created on-the-fly, called map topology, may be used when editing with an ArcView license.

Finally, geodatabases may contain rules that assist in the entering and validation of attribute data. Called domains, these rules specify which values or range of values may be entered in a particular field; a percent field, for example, should only contain numbers between 0 and 100. Other features of geodatabases that facilitate editing are discussed in Chapter 13.

**Coverages**

A coverage is a complex data format associated with the original ArcInfo software, and their use is getting rarer. Coverages contain multiple feature classes, and often some feature classes are combined to create new feature classes. For example, a polygon feature class requires a point feature class to form polygon labels and a line, or arc, feature class to form the boundaries of the polygons (Fig. 1.12). From these two feature classes, the polygon feature class is created. A region is a single feature made of multiple polygons, such as the state of Hawaii which includes several islands. Building a region feature class in a coverage requires the presence of label, arc, and polygon feature classes.
Feature classes in coverages include the spatial coordinates as well as the attribute information. Attributes are stored in INFO tables and have special names: a polygon attribute table (.pat), arc attribute table (.aat), region attribute table (.rat), etc. These feature tables also contain fields created and maintained by the GIS software, which should never be modified. The critical fields present vary depending on the feature type, but all feature classes have a cover# or cover_field and a cover-id field, where cover is the name of the coverage. (For example, a coverage named roads would have fields called roads# and roads-id.) The cover# field is analogous to the FID in a shapefile or geodatabase. The cover-id is a numeric identification code that can be modified by the user.

Coverages store information on how polygons are constructed from arcs (arc-node topology). A polygon is composed of individual arcs and a label point (Fig. 1.12). Adjacent polygons share the same arc, so it need be stored only once. The polygon table keeps track of which arcs and labels belong to each polygon, and the arc attribute table stores which polygons are on either side of an arc. Coverages may store other types of topology, such as arcs that make up a network, or multiple polygons combined together to make regions.

VERY IMPORTANT TIP: Do not use Windows to copy or delete coverages, shapefiles, and geodatabases. These data sets may span multiple files and folders, and they might not be copied or deleted correctly. Always use ArcCatalog to delete or copy spatial data sets to prevent problems.

**Introduction to metadata**

Metadata contains data about data. It includes important information such as who created it, where it came from, what coordinate system it uses, what the fields in the attribute tables mean, and more (Fig. 1.13). Without appropriate metadata, a data set can be useless.

The content and format of metadata is established by the Federal Geographic Data Committee, and metadata which follows these standards and has a certain minimal set of items is referred to as FGDC-compliant. ArcCatalog provides tools which make it easy to create and update metadata and which ensure that when the data set is copied or moved, its metadata goes with it.
A fully completed metadata set has hundreds of pieces of information and can be quite time-consuming to develop. However, much of the metadata is entered by ArcGIS itself based on information in the data set. Other required information, such as the name and address of the organization creating the data, can be copied and reused between data sets.

Finally, partial metadata is better than no metadata at all. Even if you don’t have access to all the information required by the metadata, filling out the information you do have is helpful to your organization and to any others sharing the data. As a data user, once you have had the frustration of dealing with an undocumented data set, you will come to appreciate the value of metadata.

![Diagram of ArcMap GUI](image)

**Fig. 1.14.** The ArcMap GUI includes a display window, menu bars for commands, toolbars to provide functions, and context menus for added flexibility.

**Overview of the ArcGIS interface**

The graphical user interface, or GUI, used by ArcGIS may look complicated at first, but there are many similarities between ArcCatalog and ArcMap (and other Windows applications) that make them easier to learn. The interface has also been designed to pack as many commands and functions as possible into a small space on the screen (Fig. 1.14). Moreover, it is easy to customize the GUI to provide the look and functionality desired. Let’s look at some of the unique features of the GUI by examining the ArcMap window. ArcCatalog has a similar layout.

**Menu bars and toolbars**

The menu bar is the top row of the GUI; it contains drop-down menus organized by function. You can use the Customize function to add additional commands, or even your own commands, to the menus.
ArcGIS has many toolbars, organized by function (Fig. 1.15). These toolbars can be torn out of their locations and moved to a different spot in the GUI, or even off the window entirely. You can also add your own tools to the toolbars using the Customize function.

**Context menus**

*Context menus* pop up everywhere in ArcGIS. A context menu appears when you right-click or left-click a certain object, and the menu that appears will depend on which object was clicked and which mouse button was used (Fig. 1.16). For example, right-clicking a symbol in the legend allows you to select a color, but left-clicking it lets you choose a different symbol. Right-clicking the layer name gives yet another menu. Context menus are a great way to pack a lot of commands into the GUI without cluttering it.

**Object properties**

ArcGIS is an object-based program, meaning that nearly everything in it, from a data set to a map to a button, is considered an object. The program manipulates these objects and keeps track of their properties. For example, to open a table, the program sends an Open command to the table object. Objects also have properties that define what they are and how they behave. Often accomplishing things in ArcGIS involves setting properties of various objects. For example, to draw a data layer using certain symbol colors, you set the Symbol Properties of the data layer. Or to add fields to a shapefile, you modify its Fields Properties.

Properties of data layers are accessed by right-clicking on the layer and choosing Properties from the context menu. The Layer Properties window has multiple tabs that control different properties (Fig. 1.17). As you work through this text, you will learn the properties of all sorts of objects and how to set and modify them.

Fig. 1.15. A toolbar

Fig. 1.16. Context menus are sensitive to what is being clicked and which mouse button is used.

Fig. 1.17. The Layer Properties window has tabs for viewing and modifying layer properties, such as its source data and how it is displayed.
**About ArcCatalog**

ArcCatalog (Fig. 1.18) is like having a version of Windows Explorer that is smart about spatial data and helps manage it. ArcCatalog can view data layers, set their properties, and manage data sets and files. ArcCatalog is also used to create new data sets and convert between data formats.

It should be emphasized that ArcCatalog should nearly always be used to copy, delete, rename, and modify spatial data sets. It knows the data formats and requirements and can ensure that these functions are carried out properly. Using Windows Explorer to manage GIS data files may cause damage to the data and render it unusable.

**Viewing data files**

ArcCatalog gives users many ways to view and get information about data. The left window in Figure 1.18 shows the directory tree information. The content window on the right has three main tabs to provide different views of the data: **Contents**, **Preview**, and **Metadata** (Fig. 1.19).

The **Contents** tab shows what is inside a folder or a multifeature data set.

- If a folder is clicked in the tree window, then the contents of the folder are displayed on the right. Buttons in the main button bar of ArcCatalog also switch among the display modes: large icons, small icons, details, or thumbnails.

- If a single data object such as a shapefile is highlighted, then the Contents window will show information about the object. If a thumbnail (a small snapshot), has been created for the data set, then the thumbnail will be displayed as shown in Figure 1.19.

The **Preview** tab shows what the data set contains. You can switch between viewing the spatial features and viewing the attribute table associated with the features by clicking on the drop-down box at the bottom of the Contents window to set it to Geography or Table.

- In Preview mode, you can use the Zoom and Pan tools to zoom in and out, pan, and return to the full extent of the data set (Fig. 1.20).

- You can use the Identify tool to get information about a feature in the map.
You can use the Thumbnail tool to create a thumbnail for the data set. If you are zoomed in when creating the thumbnail, it will create it according to how the map currently appears.

The Metadata tab allows the user to view, create, edit, update, and import/export metadata for a data layer (Fig. 1.21).

- The drop-down Stylesheet tab allows a choice among several formats for displaying the metadata.

- The Metadata editing tools allow users to easily create and update metadata. ArcCatalog itself fills out many of the required fields automatically.

**About ArcToolbox**

ArcToolbox contains an assortment of functions, or tools, for managing and analyzing data. The commands are implemented as easy-to-use menus. The tools are organized into a hierarchical system of toolboxes containing related tools (Fig. 1.22). If the user has purchased optional program extensions to ArcGIS, such as Spatial Analyst, that functionality will appear as additional toolboxes. Users may also create their own toolboxes inside ArcToolbox and fill them with frequently used tools, or even create new tools to put in them.

The functions available in the toolbox depend on the software license obtained. Users holding only an ArcView license will find mainly functions to perform common analysis tasks, to convert between basic data formats, and to work with map projections. This includes about 30 functions. The ArcEditor license adds a few functions associated with editing. The ArcInfo Toolbox is packed with capabilities.

ArcToolbox is a powerful part of the ArcGIS “geoprocessing environment,” a new concept implemented in Version 9 that aims to provide seamless analysis and management functions that work across the entire ArcGIS system. Tools in ArcToolbox can be run from either ArcMap or ArcCatalog, and most are designed to work with all spatial data types, including shapefiles, coverages, and geodatabase feature classes.
The geoprocessing environment includes an application called ModelBuilder, which allows users to string tools together with input and output layers to create more complex tools (Fig. 1.23). These models can streamline processing when several analysis steps are always repeated in the same order. The new models can be saved in the toolbox and run as needed. Users can also write scripts, or programs which string together analysis steps. Like models, scripts can be used over and over to perform the same series of functions on different data layers. Tools, models, and scripts can all exist in ArcToolbox. Advanced users will want to learn more about the geoprocessing environment, models, and scripting, because all three help streamline GIS work and can add flexibility and power to the user’s repertoire of GIS tricks.

The geoprocessing environment utilizes environment settings that control many aspects of how tools work. For example, users can set a default working directory where all outputs are placed, or specify that resulting layers occupy only a restricted geographic area of interest. The default settings provide a reasonable service for all the exercises in this book. Users interested in advanced geoprocessing will need to learn more about these settings prior to changing the defaults.

Fig. 1.23. The ModelBuilder application
Summary

- A Geographic Information System is designed as a database system that uses both spatial and aspatial data in order to answer questions about where things are and how they are related. It has many functions, including creating data, making maps, and analyzing relationships.

- Raster data employ arrays of values representing conditions on the ground within a small square called a pixel. The array is georeferenced to a ground location using a single x-y point.

- Vector data use sequences of x-y coordinates to store point locations, lines, and polygon area features. Every feature is linked to an attribute table containing information about the feature.

- GIS software by ESRI, Inc., has a long history with several major transformations along the way. The current version of ArcGIS Desktop employs a menu-based interface, with optional access to the older command-line functionality of Arc/Info. The Desktop consists of three programs, ArcMap, ArcCatalog, and ArcToolbox.

- ArcGIS uses a variety of data formats, old and new, including shapefiles, coverages, geodatabases, grids, images, TINs, and CAD drawings.

- Metadata files store information about GIS data layers to help people understand and use them properly. Metadata can be created in ArcCatalog, and the files are automatically copied and updated along with the data sets.

- The ArcGIS Desktop interface uses menus, toolbars, and context menus to facilitate the display, management, and analysis of data. Use these features to access and modify objects such as data layers, tables, and reports.

- ArcCatalog contains many functions for creating data, exploring files, and managing GIS data. It also provides tools for viewing and editing metadata.

- ArcToolbox contains functions for processing, managing, and analyzing GIS data. Users may customize it by building models or writing scripts to repeat often-used sequences.

**VERY IMPORTANT TIP:** Do not use Windows to copy or delete coverages, shapefiles, and geodatabases. These data sets may span multiple files and folders and might not be copied or deleted correctly. Always use ArcCatalog to delete or copy spatial data sets to prevent problems.

**IMPORTANT TIP:** Although spaces are permitted in names of files and folders, they can cause problems for some GIS functions. It is recommended NEVER to use spaces when naming files and folders that will contain GIS data, nor to let spaces appear in any folders above them.
Chapter Review Questions
You may need to consult the Skills section at the end of the chapter to answer some of these questions.

1. What feature most distinguishes a Geographic Information System (GIS) from a Database Management System (DBMS)?

2. Explain the relationship between Arc/Info and ArcGIS Desktop.

3. Explain how a raster is georeferenced.

4. If each of the following data were stored as rasters, state which ones would be discrete and which ones would be continuous: rainfall, soil type, voting districts, temperature, slope, and vegetation type.

5. Imagine you are looking at a database which contains 50 states, 500 cities, and 100 rivers. How many feature classes are there? How many features? How many attribute tables? How many total records in all the attribute tables?

6. Of the three vector data formats, shapefiles, coverages, and geodatabases, which ones can store multiple feature classes? Which one is the most recent? Which one is a single file? Which ones can store points, lines, and polygons?

7. What does it mean to connect to a folder in ArcCatalog? What is the benefit of this feature?

8. What functions can be performed on a table while previewing it in ArcCatalog?

9. Can the Search function in ArcCatalog do more than locate files by finding their names? What other kinds of search can it do?

10. What is metadata and why is it important?
Mastering the Skills

Teaching Tutorial

Preparing to begin

Each step of the tutorials in this book is illustrated by a video clip on the book’s CD. You can view these clips whenever you want a demonstration of one of the steps in the tutorial. To view videos, do the following.

- Place the book’s CD in the computer’s CD-ROM drive. Wait for the splash screen to appear.
- Click the button to accept the license agreement. The main window appears (Fig. 1.24).
- If needed, size the document window to a narrow strip on the left side of the screen, so that you can see all the numbers and titles clearly. Put your ArcMap window on the right, so you can see it also.
- In the Chapter 1 section, click on the number of the tutorial video you want to see. Windows Media Player will start playing the clip. If asked whether you want to open the clip in Windows Explorer, say NO.
- Size the play window as large as possible for best resolution.
- When the video finishes, click the Minimize button in the upper right corner of the Media Player window, to get it out of the way.
- The headings under the Skills section contain links to performing different skills introduced in the chapter. Use these videos as a reference if you have forgotten how to do something.
- Before starting the tutorial, make sure that you have installed the rgisdata folder from the CD to the computer hard drive. See the Preface for detailed instructions.

ArcGIS demonstration

The following examples provide step-by-step instructions for doing basic tasks and solving basic problems in ArcGIS. The steps you need to do are highlighted with an arrow ➔; follow them carefully. Click on the video number in the Video Index to view a demonstration of the steps.

We will begin with an overview of ArcMap just to highlight some of its capabilities as a preview to what GIS is about. You will learn more about these functions in the chapters to come.

- Start ArcMap.
- ➔ Click the button next to An Existing Map and click Browse for Maps in the box below. Click OK.
1. Navigate to your mgisdata directory and open the MapDocuments folder. Click on the ex_1.mxd document and click Open.

2. Choose Save As from the File menu and save a copy of the map document under a new name, such as ex_1mine.mxd. Then save periodically as you work.

**TIP:** In these tutorials, values you must enter are shown in this font: type this.

You will see a map of Oregon in the display area on the right, and a list of data layers in the Table of Contents area on the left. First let’s explore some of the data layers.

1. Locate the Identify tool on the Tools toolbar and click on it. The Identify window appears.

2. Place the tool on top of one of the towns and click. The town will briefly flash on the screen, and the attributes of the town are displayed in the Identify window.

3. Close the Identify window by clicking the X in the upper right corner.

**TIP:** You must click exactly on the center of the point to identify the town. If you are a little off, you may get county or river information instead. Try clicking the town again.

Toolbars in ArcMap can be moved and docked at different locations, even outside the program. Hold down the Ctrl key while moving a toolbar to prevent it from docking.

1. Locate the toolbar with the Identify button again (called the Tools toolbar). At its top or left, find a faint grey line. This is its handle.

2. Click the line and drag the toolbar out of the ArcMap window. Then click it and drag it to a spot with the other menu bars at the top of the window. Leave it wherever you like.

The Find tool is a handy way to seek a feature. It will look for features having a specified string across all the layers in the map or an individual layer. It can also search all fields or confine the search to a single field.

1. Click the Find tool (Fig. 1.25).

2. Make sure the Features tab is clicked so it is active.

3. Enter the name Jefferson.

4. Choose Counties as the layer to search.

Fig. 1.25. Using the Find tool

5. Click Find.
Chapter 1

4→ When the feature has been found, choose it from the list and right-click on its name. Choose Flash and watch for it to flash on the screen (Fig. 1.25). (Move the Find window away from the central part of Oregon, if needed, so you can see.)

4→ Now right-click on Jefferson again in the Find window and choose Select. Notice that the feature you chose is highlighted in the map with a blue line. When you have seen it, right-click the name again and choose Unselect.

4→ Click the Cancel box to close the Find window.

Now let’s use the measuring tool.

5→ Locate and click on the Measure tool.
5→ Click on the lower left corner of the state and then click on the lower right corner.
5→ Double-click to end the line.
5→ Read the distance in the Measure tool window.

1. How far is it across the southern border of Oregon? ____________

6→ Click on the large city in the northwest (Portland), and then click along the interstate that travels south from it, approximately following the curves to where it crosses the southern border of Oregon. Notice that the Measure tool reports the total length as well as the last segment.

6→ When you get to the end, double-click to end the line and read the total length of the interstate.

2. What is the driving distance from Portland to the southern border? ____________

3. What is the name of the large city about halfway down? (Hint: Use Identify.) ____________

The Measure tool is actually an entire set of tools for finding lengths, areas, perimeters drawn on the screen, or of features. Let’s try a few; then play with it to find out more on your own.

7→ Click on the Measure an Area tool, and click to create a polygon that corresponds to one of the parks.

8→ Change to the Measure Feature tool, and click on the same park to get an exact measurement.

8→ Click on the Choose Units button, set the Area units to hectares, and click the park again.

8→ Click the Clear and Reset Results button. Play with these tools a little more if you wish. Then close the Measure window.

Map Tips are little flags that pop up and give the name of a feature when the cursor is held over it. They are useful for identifying features quickly. The Parks layer currently has the Map Tip function turned on. Let’s see how they work.
9 ➜ Use the cursor to hover over one of the Parks until the name of the feature is displayed. You may need to gently move the cursor around to find the right spot. Try several different parks to get the hang of it.

Now let's learn how to turn the Map Tips on and off.

10 ➜ Right-click the Volcanoes layer name and choose Properties from the menu.
10 ➜ Click the Fields tab and verify that the Primary display field is set to NAME. This is the field shown in the Map Tips.
10 ➜ Click the Display tab and check the box next to the words Show Map Tips.
10 ➜ Click OK to close the Properties box and keep the changes just made.

11 ➜ Turn the Volcanoes layer on by clicking the check box next to its name.
11 ➜ Use the cursor to hover over a volcano marker until a small yellow box appears with the name of the volcano. Find out the names of some other volcanoes.

**TIP:** If the Show Map Tips text is dimmed in the Display Properties menu, then no spatial index currently exists for the data layer. Spatial indices must be created in ArcCatalog before Map Tips can be used.

Now we will experiment with the zooming buttons.

12 ➜ Uncheck the Volcanoes box in the Table of Contents so it is not being displayed.
12 ➜ Check the Hospitals layer to display it.

**TIP:** If you do not like the area you chose, or if you made a mistake, click the Previous Extent button to return to the original extent. You can use the Next Extent button to move back the other way.

12 ➜ Click the Zoom In tool. Place the cursor at the upper left corner of the state and click and hold. Continue holding the mouse button down and drag a box down and right to include the greater Portland area. When finished with the box, let go of the mouse button.

13 ➜ Click once on Portland and notice that the view zooms in and places the city at the center.

13 ➜ Click on the Zoom Out tool and click on Portland again. The view zooms out with Portland still at the center. Both Zoom In and Zoom Out place the clicked spot at the center of the new field of view.

**TIP:** You can also draw a box using the Zoom Out tool. If a large box is drawn, the view zooms out a little bit. If a small box is drawn, the view zooms out a large amount.

13 ➜ Click on the Pan tool; then click and drag inside the display window to move the map around. When you release the mouse button, the map redraws.
14→ Click the Fixed Zoom Out button a few times to zoom out. Notice that the center stays put.
14→ Click the Fixed Zoom In button a few times to zoom in.
14→ Click the Full Extent button to view the total area of all the layers in the Table of Contents.

**Bookmarks** provide a handy way to zoom into extents that you use frequently, or that you want others to be able to find easily.

15→ Click on the View menu and choose Bookmarks > Portland from the menu.
15→ Click the Full Extent button to return to all of Oregon again.

It is easy to create and manage bookmarks.

16→ Use the Zoom In tool to draw a box around the Eugene area (Fig. 1.26).
16→ Click on the View menu and choose Bookmarks > Create.
16→ Type Eugene in the box to name the bookmark and click OK.
16→ Return to the Full Extent, and then use the new bookmark to zoom into Eugene again.

**TIP:** Use View > Bookmarks > Manage to examine and remove bookmarks.

**Scale Range** is a layer property that allows additional control for displaying features. Map scale is the ratio of units on the screen to units on the ground, such as 1 cm on the screen equals 50,000 cm on the ground (1:50,000). You can specify a range of map scales at which the map layer is drawn, to avoid cluttering maps with too much information. Try it with the Schools layer.

17→ Return to the Full Extent.
17→ Turn on the Schools layer. Notice how some areas are nearly obscured by schools because there are so many.
17→ Right-click the Schools layer name and choose Properties from the menu.
17→ Click the General tab if it is not already displayed.
17→ Fill the box next to Don’t show layer when zoomed: and enter the value 500000 in the box for out beyond. Notice that the current scale is approximately 1:4 million in the scale box on the main toolbar (Fig. 1.27).
17. Click OK, and watch the schools disappear from the map. Note that the check box next to the layer name is now dimmed.

17. Use the bookmark to zoom into Eugene again, and the schools should appear. If not, then use the Zoom In tool to keep zooming in until the schools appear.

ArcMap provides many options for displaying features using different symbols. In this map we see two basic ones: displaying every feature in the layer with one symbol (the hospitals, for example), and displaying features based on an attribute (the roads). We will now learn how to modify these symbols.

18. In the Table of Contents, right-click the Schools symbol (not the name). A menu of colors will appear. Choose a bright red color for the schools.

The Symbol Selector can modify the type, size, and color of each symbol.

18. Click on the Schools symbol in the Table of Contents. The Symbol Selector window appears (Fig. 1.28).

18. Scroll down the window showing the symbols until you find the School 2 symbol. Click on it to select it. Then click on the color patch to select a red color for the school, and set the size to 16 pts. Click OK when finished.

Next we will learn how to assign symbols based on an attribute.

19. Click on the Full Extent button to zoom to the state. Turn off the Parks layer.

19. Right-click on the Counties layer name and choose Properties from the menu.

19. Click the Symbology tab.

19. In the box on the left (#1), click Quantities > Graduated Colors (Fig. 1.29).

Fig. 1.28. The Symbol Selector window

Fig. 1.29. The Symbology tab of the Layer Properties window
19 ➔ Use the drop-down Value box to choose the field POP2003 (#2).
19 ➔ Use the Color Ramp drop-down box to choose a light green color ramp (#3). Click OK to produce the map (Fig. 1.30).

Now we are going to use selection to extract a certain subset of records to look at, based on their values in a field of the attribute table. This action is called a **query**. Once records are selected you can examine their distribution on the map, get statistics about them, export them to a new data file, and many other operations.

20 ➔ Right-click on the Counties layer and choose Open Attribute Table from the context menu which pops up.
20 ➔ Examine the attribute fields in the table. Use the scroll bar at the bottom to scroll right to see the fields that are out of the display area. Notice that these fields contain mostly demographic information.
20 ➔ Scroll all the way out to the right end of the table. Notice the two fields Shape_Length and Shape_Area. These fields are automatically created for feature classes in geodatabases. In this case the length and area values are given in meters.

21 ➔ Click on the Options button in the table and choose Select By Attributes.

In the dialog box you will enter an expression to find all counties with a population greater than 100,000 people. It will look like this [POP2003] > 100000. (When entering field names, you must include brackets for geodatabase feature classes, or quotes for shapefiles.)

21 ➔ Double-click on [POP2003] from the list of fields. Check to make sure the field name appears in the box below.
21 ➔ Click once on the > sign.
21 ➔ Type 100000 from the keyboard (without quotes or commas). Click Apply.
21 ➔ Close the Select By Attributes box by clicking on the X in the upper right corner.
21 ➔ Move the table window away from the map by clicking on its title bar and dragging it to one side, so you can see the map clearly.

Examine the map, noticing that the counties with population greater than 100,000 are now outlined in blue and that their associated records in the table are also highlighted in blue. (You may need to scroll down the table to find a highlighted county.)

22 ➔ Click the Selected button on the table so that only the selected records are displayed.
22 ➔ When done examining the selected records, click the All button to show all of them again.

You can use the Statistics command to calculate basic statistics about the selected records (or about all of the records if none of them are selected).
23 ➔ In the table, right-click on the name of the POP2003 field and choose Statistics from the context menu.
23 ➔ Examine the statistics and the frequency diagram. Note that only the selected records are used to calculate the statistics.

4. How many counties are currently selected? ___________________

5. What is their total population? ___________________

24 ➔ Use the drop-down box to choose another field and view its statistics.
24 ➔ Close the Statistics box.
24 ➔ Click Options and choose Clear Selection from the menu.
24 ➔ Close the attribute table.
➔ Exit ArcMap by choosing File > Exit or by clicking the X box in the upper right corner of the ArcMap window. Save the changes to the map document when prompted.

**Exploring data with ArcCatalog**

ArcCatalog (and ArcMap) access data through **connections**, which are links to folders containing GIS data. By default, the main computer hard drive will always show as a connection (C:).

➔ Start ArcCatalog.
25 ➔ Examine the folder tree on the left side and find the default connection, C:.
25 ➔ Click the plus sign next to it to expand the contents of the drive and see the subfolders.

Although you can navigate through folders to find any data on C: from the default connection, you can also establish connections to subfolders, thus creating handy shortcuts to frequently used data. You may already have one shortcut to the mgisdata folder, or it may be absent. If no mgisdata connection exists, then you can add one.

25 ➔ Look for a connection to the mgisdata folder as shown by the red oval in Figure 1.31. The first part of the name may be different, depending on where the data were installed (such as C:\student\mgisdata).
25 ➔ If the connection is already there, go on to step 27.

➔ To add the connection, click the Connect to Folder button.
26 ➔ Navigate to the directory containing your mgisdata, and click on the mgisdata folder to select it. Do not select any of the subfolders, just the mgisdata folder.
26 ➔ Click OK to add the connection.

Fig. 1.31. A connection to the mgisdata folder in ArcCatalog
Adding connections is critical for accessing data not on the main hard drive, such as on a second disk drive, a network drive, or a CD-ROM drive. Connections are saved between sessions, and they work in ArcMap and ArcToolbox as well. Once you add a connection, it will be present until you delete it. Connections tend to build up over time, so once in a while go through them and delete ones no longer being used. Also, having multiple pathways to the same folder, such as through connections to C:/MGIS/mgisdata and C:/MGIS/mgisdata/World, can cause unstable behavior in ArcGIS. Keep your connections as uncluttered and simple as possible.

27→ Locate the connection to the mgisdata folder just added. Click to select it and then click the Disconnect button. It disappears from the list.

27→ Click the Connect button, navigate to the mgisdata folder, and add the connection again.

Now let’s examine some features of ArcCatalog. First, you can use the Options in ArcCatalog to control a number of convenient features.

28→ Adjust the folder tree by clicking the plus signs until you can see the mgisdata\MapDocuments folder, and click it to highlight it.

28→ Click the Contents tab in the ArcCatalog main window.

28→ Click Tools > Options on the main menu bar.

28→ Click the General tab.

The General tab can control which types of files and services appear in the Catalog. By default, all are shown. You can also choose to hide or show file extensions, such as .shp or .mxd.

**TIP:** Another option is to show a special icon for folders containing GIS data. This option may be handy at times, but it does slow down the performance of ArcCatalog.

28→ Uncheck the box next to Hide File Extensions.

28→ Click OK to close the Options menu and apply the changes. Notice that the map documents now appear with an .mxd extension.

29→ Open the Options menu again and click the File Types tab. Examine the option to add additional non-GIS file types for display, such as Word documents.

29→ Click the Contents tab. By default, ArcCatalog shows only the name and type of file. Click to add the file size to the list. Click OK and examine the documents to see the change.

**TIP:** You can click the edge of a contents column and drag it to increase or decrease the column width.
We will examine some of the other options as we go along. For now, let's practice viewing files in ArcCatalog. Figure 1.32 shows many of the ArcGIS file types and their icons.

30 ➜ Adjust the folder tree so that you can see the contents of the mgisdata\Rapidcity folder (Fig. 1.32). (It will not match the figure exactly.)

30 ➜ Examine the icons in this folder. These are only some of the many types of spatial and attribute data that ArcCatalog can use.

30 ➜ Click the plus sign next to the citybrd layer. The expanded list shows each of the feature classes of the coverage. The shapefiles do not expand because they can only have one feature class. Recall that a polygon coverage would have a minimum of three feature classes that make up the polygons: arcs, labels, and polygons. Other features such as tics and regions may also be present.

30 ➜ Expand the TM_24sep98MS raster layer to see the seven color bands that make up this image. Each band shows a different range of light wavelengths as measured by the Landsat satellite.

30 ➜ Click one of the feature files in this directory, and notice the information that appears in the main window when the Contents tab is clicked. A coverage lists all the feature classes. A shapefile has a name and a thumbnail picture, if one has been created. You will learn to create thumbnails in a few minutes.

31 ➜ Close the Rapidcity folder contents by clicking on the minus sign in the box next to it. Click the plus sign to expand the Oregon folder.

31 ➜ Expand the oregon.mdb personal geodatabase (Fig. 1.33). Expand the Transportation feature dataset to see the feature classes (including two line feature classes and one point feature class).


Fig. 1.32. Data sets in ArcCatalog

Fig. 1.33. A geodatabase in ArcCatalog
Chapter 1

The Contents tab provides some useful information and is also the fastest option when exploring in ArcCatalog. It also has several ways to display the contents of folders: as large icons, as a list with small icons, as a detailed list, and as thumbnails. The view style is controlled using these buttons (Fig. 1.34).

31. Click the Oregon geodatabase to select it, and then click each of the view buttons in turn. When finished, set it back to List.

ArcCatalog has more ways to explore data: the Preview tab and the Metadata tab. The Preview tab shows a quick sketch of the data layer or a look at its tables.

32. Select the geologywest shapefile in the mgisdata\Rapidcity folder, and note the appearance of the main window, showing a thumbnail of the data set.

32. Click the Preview tab. The view changes to display the polygons using a random symbol.

32. Experiment with the Zoom and Pan tools to examine areas of the geology more closely. These buttons work the same as the ones in ArcMap.

32. Click the Identify button and click on a polygon to get information about it. Close the Identify window when finished.

33. Click the Create Thumbnail button to create a snapshot of the current view. Nothing apparently happens, until....

33. Click the Contents tab. This time the thumbnail appears with the data set name and information.

33. Click the Rapidcity folder to select it. Click the view tab to the thumbnail option. All of the data layers appear with thumbnails, if they have been created, or icons.

33. Return to Preview mode and make several more thumbnails; then examine them again using the Contents tab.

Not only can you preview a data set’s features, but you can also look at its attribute table, change the appearance of the table, and even add and delete fields.

34. Click on the landuse coverage, make sure the Preview tab is clicked, and choose Table from the drop-down menu that currently reads Geography. The landuse table appears.

34. Scroll to the right through the end of the table, noting all of the fields.

7. How many records (rows) are there in this table?

34. Hold the cursor over the right edge of the LU_CODE field until it turns into a double arrow bar. Click and drag the edge to the left or right to reduce or increase the width of the column.

34. Click the Options button in the table window (if necessary, expand the window to the right to see it better).
Note the menu options. Find searches the table for particular text, as has already been demonstrated. Add Field adds a new field to the table, and Export saves a copy of the table as a .dbf file. Other options are also available.

35→ Right-click the field name AREA to display a context menu. Choose Sort Ascending or Sort Descending to sort the field.

8. What is the land use code of the largest polygon in this data set? ____________ Of the smallest one? ____________

35→ Right-click the area field and choose Statistics to see basic statistics and a frequency diagram of the values. Close the Statistics menu when done looking.
35→ Right-click the LU_CODE field and choose Freeze/Unfreeze. This places the field to the left of the table and keeps it there as you scroll to the right.

TIP: More than one field can be frozen at a time. Unfreezing allows the field to scroll again, although it remains on the left side until ArcCatalog closes.

You can even add or delete fields from the table in Preview mode.

36→ Click the gas_stations shapefile to select it, and examine the fields.
36→ Click the Options menu and choose Add Field.
36→ Type NOTES for the field name.
36→ Use the drop-down box to set the field type to Text.
36→ Enter a length of 25 for the field. (For numeric fields don’t change any of the field properties until you are more experienced.) Click OK.
36→ Scroll to the right to see the new field added to the end of the table. Data are added to fields in ArcMap.
36→ Right-click the new NOTES field and choose Delete Field. Choose Yes in the warning box.

You can also search for information in a field or in the entire table.

37→ Click the Options button and choose Find.
37→ Enter Sinclair as the text to search for.
37→ Examine the find options available, and then click the Find Next button.
37→ Note the first Sinclair station is found. Close the Find box.

TIP: Except for the Add/Delete field options, none of these operations changes the data that are stored on the disk. You can sort, freeze, and do statistics without making a single change to the actual data.


**Layer properties**

Every data set has various properties that can be viewed and set in ArcCatalog. We will examine some of these properties now to start getting familiar with them. The succeeding chapters will cover how to work with the properties.

38→ Find the Rapidcity folder in your mgisdata directory in ArcCatalog.
38→ Right-click the gas_stations feature class and choose Properties from the context menu.
38→ Click the General tab. There is not much to set here.
38→ Click the Fields tab. You can view, add, and delete fields here too, and will learn to do so in Chapter 5.
38→ Click the Indexes tab.

Feature classes can have two types of indices. An attribute index can be created for individual fields and enhances performance when searching or querying that field. A spatial index decreases the time needed to draw and query the layer.

Shapefiles, coverages, rasters, and geodatabases all have different properties. Let’s look at the properties for coverages.

39→ Close the Feature Class Properties window.
39→ Right-click the citybnd coverage and choose Properties from the menu.
39→ Click the General tab.

Recall that coverages are topological data sets, meaning that they store spatial relationships between features. The General tab shows and updates the topology of the feature classes in a coverage. Notice the Build and Clean buttons, which are used to generate and update topology.

9. Which feature classes are present in this coverage? ________________

39→ Examine the Projection tab. This tab lists the coordinate system, which you will learn about in Chapter 3.
39→ Examine the Tics and Extent tab. Tics are locations with known real-world x-y coordinates, used to register a paper map on a digitizer and allow it to be converted to a digital map with a real-world coordinate system. The Extent shows the range of x-y coordinates present in the data set.
39→ Examine the Tolerances tab. These tolerances are used during editing and when updating topology.
39→ Click OK to close the Coverage Properties box.

Next we will examine properties of feature classes in a geodatabase. These are similar to shapefile properties, except that two additional tabs for Subtypes and Relationships are added. Subtypes are rules used to help validate data entry, and Relationships establish links between tables. Note that the feature datasets and the geodatabase itself have different properties than the feature classes inside it.

40→ Expand the oregon geodatabase in mgisdata\Oregon so the feature classes are visible.
40→ Right-click the parks feature class and choose Properties. Examine each of the tabs in turn. Close the Properties box when finished.

40→ Right-click the Transportation feature dataset and open its properties. Examine each of the tabs and close when finished.

40→ Right-click the oregon.mdb geodatabase and examine its properties. Notice that it only has two tabs, General and Domains.

41→ Finally, examine the properties of one of the rasters and one of the tables in the mgisdata\Rapidcity folder.

Next we will briefly examine some ways to create a geodatabase and put feature classes in it.

42→ Right-click the mgisdata folder and choose New > Folder from the context menu.

42→ When the folder appears in the tree, type in the name MyFolder and press the Enter key.

**IMPORTANT TIP:** Although spaces are permitted in names of files and folders, they can cause problems for some GIS functions. It is recommended NEVER to use spaces when naming files and folders that will contain GIS data, nor to let spaces appear in any folders above them.

42→ Right-click MyFolder and choose New > Personal Geodatabase.

42→ Give the geodatabase the name mydata.

43→ Right-click the geodatabase and choose Import Feature Class (single). A tool appears. You need to specify the inputs marked with green dots.

43→ Expand the Rapidcity folder. Click on the gas_stations shapefile and drag it on top of the tool; then drop it in the box labeled Input Features.

43→ Click in the Output Feature Class box in the tool and type gas_stations. Click OK to start importing.

You can also create new feature classes, but then these must be edited to put features inside them. Chapters 11 and 12 cover editing. Until then, we will primarily use the Import function to add feature classes to a geodatabase, or they will be placed there as outputs from various tools.

Geodatabases can import either shapefiles or feature classes from coverages. Coverages contain multiple feature classes, so only one should be specified during an import.

44→ Right-click the geodatabase and choose Import Feature Class (single) again.

44→ Click the plus sign to expand the contents of the landuse coverage.

44→ Drag the polygon feature class over to the Import tool and drop it in the Input Features box.

44→ Name the Output Feature Class landuse. Click OK.

As another example, let’s create a layer file. A layer file references another spatial data set and stores information on how it is displayed. The layer file can be displayed in ArcCatalog to give a more detailed picture of the data. It can also be added to ArcMap to easily draw the features a specific way, or it can be used to specify symbols for another data layer.
45 ➔ Right-click MyFolder and choose New > Layer from the menu.
45 ➔ Type in MyStates for the layer name.
45 ➔ Click the Browse button in the Create New Layer window and navigate to the mgisdata\usa\usdata.mdb geodatabase. Click the states feature class to select it and click Add.
45 ➔ Keep the check in the Create Thumbnail box. Also place a check in the Relative Pathname box. This ensures that as long as the files retain the same relationship to each other in their folders, they will continue to work even if the entire directory structure is moved. Click OK.

46 ➔ Click on the new layer to highlight it; then click the Preview tab.
46 ➔ Right-click the MyStates layer and choose Properties. Click the Symbology tab.
46 ➔ If you want to, try using the example in the tutorial you did earlier to create a Quantities: Graduated Colors map of the states using POP2000 as the Value field.

47 ➔ After you click OK, the symbols for the layer may not update in the Preview window. Click the Contents tab, and then click the Preview tab again. The new symbols should appear now.
47 ➔ Zoom in to the lower 48 states. Click the Thumbnail button to create a new thumbnail for the layer.
47 ➔ Click the Contents tab to view the new thumbnail (Fig. 1.35).

Viewing metadata

We rely on metadata to provide information when data sets are sold or shared, or even when we come back to a data set months later and cannot remember the details about it. However, one must make a commitment to building and maintaining metadata, because it does take time and vigilance. Fortunately, ArcMap has the tools to make it easier.

48 ➔ In ArcCatalog, navigate to the mgisdata\usa folder, expand the usdata geodatabase, and click on the states feature class to select it.
48 ➔ Click the Metadata tab.
48 ➔ Make sure that the Stylesheet drop-down box on the Metadata toolbar says FGDC ESRI. Examine the information.
48 ➔ Click on the green text Abstract. The abstract information folds up and is no longer visible. Click Abstract again to display the text once more.
48 ➔ Scroll down and click Publication Information. It tells who created the data and who published it.

49 ➔ Click the Spatial tab at the top of the metadata. It switches to another “page” that contains information about the coordinate system, extent, and accuracy of the data.
49→ Click the Attributes tab to see a list of the fields in the attribute table, their definitions, and their descriptions.

49→ Click the AREA attribute and read the information about it. Notice that the description indicates the units are square miles. Had the creator of this data set not entered this information into the metadata, the user might have no idea whether the areas represented square miles or square kilometers.

Already you are beginning to see how incredibly useful these data are. They are so important that a federal organization, called the Federal Geographic Data Committee (FGDC), has compiled standard rules about what kind of information goes into metadata, and how it is organized and stored. This allows everyone to define and manage metadata more easily, find the information they are looking for, and use software tools to create and maintain the data. These rules comprise the FGDC Metadata Standard. The FGDC standard format is a text file with a very specific layout so that different programs can find the information they need.

50→ Click the Stylesheet drop-down tab in the metadata toolbar and change it from FGDC ESRI to FGDC Classic.

50→ Scroll down to examine the information, and then return to the top of the document.

Metadata contains seven main sections shown as hyperlinks to the information in the document. The metadata standard has hundreds of “fields” of information, organized into groups and subgroups for easy access. The field names are shown in italics, and the information in plain text.

The ESRI stylesheet uses exactly the same information but presents it in a different way, or style (hence the name stylesheet). The information itself is stored in a document using a formatting language called XML, or Extensible Markup Language. It is very similar to the HTML used to create Web page documents, but has additional commands. Several other stylesheets can be used in ArcCatalog to view the metadata—but it is all coming out of the same .xml file.

50→ Change the stylesheet to XML to see what this file looks like. Then set it back to the FGDC ESRI stylesheet.

ArcCatalog uses the information already stored in the data sets to fill out certain fields in the metadata, such as the coordinate system, the spatial extent, and the fields. If these characteristics change, ArcCatalog will automatically update the metadata. By default, metadata is created, or updated, every time the user looks at the metadata sheet. The Metadata options control whether update occurs automatically or manually.

51→ Choose Tools > Options from the main menu bar and click the Metadata tab. Read through the options, but do not change them at this time. Click Cancel when done.

51→ Click the Create/Update Metadata button to update metadata manually.

The rest of the metadata fields must be entered by the user. Metadata is a complex topic and requires training beyond the scope of this book to fully understand it and create it. For detailed information and copies of the metadata standard, refer to the FGDC website for geospatial metadata standards: www.fgdc.gov/metadata/contstan.html.
This is the end of the tutorial. However, you may do the following optional exercises on Internet map servers and searching if desired.

⇒ If stopping here, close ArcCatalog.

**Working with Internet map services (optional)**

You can utilize the Internet to locate, view, and copy data as well. Many organizations maintain server sites that provide valuable data. Some of these sites are free. One major site developed by ESRI, Inc. is the Geography Network. It offers two main types of services: image service and feature service. A feature service allows people to download and save the information as shapefiles. An image service allows people to display and query the data, but they cannot save the features.

52⇒ Click the Contents tab in the ArcCatalog window.
52⇒ Scroll down to the bottom of the folder tree and find the entry labeled GIS Servers.
52⇒ Expand it if necessary, and double-click the icon labeled Geography Network Services. It may have a little red X on the icon, indicating it is not currently active.
52⇒ Expand the plus box of Geography Network Services to view its contents.

The red X disappears and a list of services appears as icons. These service entries are similar to other ArcCatalog data sets, and they can be viewed with the Contents and Preview buttons just like other data sets. The only difference is that the information is transmitted via the Internet. Preview works slowly with Internet data, so it is best to keep ArcCatalog in Contents mode until you want to see a specific layer.

53⇒ Locate the FEMA_Flood service in the list and click it to highlight it.
53⇒ Click the Preview tab. Zoom in to the United States for a closer look.
53⇒ Click the ArcMap icon to start the program, and choose to begin with a new, empty map. Position the ArcMap window so you can see it when in ArcCatalog.
53⇒ Click and drag the FEMA image service into the ArcMap window. Switch to ArcMap to view the FEMA service.

54⇒ Notice the many layers added to the Table of Contents in the ArcMap window. Many of these have special scale ranges and will not appear until you zoom in.
54⇒ Zoom in to the state of New Jersey. Several cities should appear now.
54⇒ Zoom very closely in to the Philadelphia area (draw a small box around just the yellow city symbol).
54⇒ The FEMA flood zones of the Delaware River should now be visible, color-coded by type in shades of green. Expand the Flood Hazard Areas layer to view the legend.

Now let's save a copy of some data from a feature service.
55 ➔ Still in ArcMap, right-click the FEMA_Flood service at the top of the Table of Contents and choose Remove.
55 ➔ Switch back to ArcCatalog. Locate the EPA Hazards FS feature service and click the plus sign to expand it.
55 ➔ Preview the Superfund Sites layer. Then preview its table.
55 ➔ Right-click the Superfund Sites layer and choose Export. Save it to the mgisdata\usa\usdata geodatabase as supersites. Now it can be accessed at any time.

56 ➔ Switch to ArcMap and use the Add Data button to add the supersites and states shapefiles to the map. If a warning about the coordinate system appears, click Close to continue.
56 ➔ Right-click the supersites layer and choose Properties from the menu.
56 ➔ Click the Display tab and turn on Map Tips.
56 ➔ Click the Fields tab and set the Primary Display field to HUD_EPA_2 (the site name). Click OK.
56 ➔ Zoom in to Maine.

10. What is the name of the easternmost superfund site in Maine? __________________________

➔ Explore more of the Geography Network services, if you have time.
57 ➔ When finished, close ArcMap and do not save your changes.
57 ➔ Switch back to ArcCatalog and locate the Geography Network Services entry in the folder tree. Right-click it and choose Disconnect.

This is the end of the optional tutorial section.

➔ Close ArcCatalog and ArcMap.
Exercises
These exercises are all intended to be done in ArcCatalog.

1. How many feature datasets are there in the rapidnets geodatabase in the mgisdata\Rapidcity folder? List their names.
   How many total feature classes does it have (including the network classes)?
   How many each of point, line, and polygon feature classes does it have?

2. What is the coordinate system of the utmzones shapefile in the mgisdata\World folder?

3. What four data field types are present in the country shapefile attribute table in the mgisdata\World folder?

4. What is the positional accuracy of the majrdnet feature class in the mgisdata\USA folder?

5. What is the largest lake in the United States? What is its area?

6. Which state has a county named Itawamba?

7. What is the minimum, maximum, and average number of nozzles in Rapid City gas stations?

8. How many rasters does the mgisdata\BlackHills\rasters folder contain? List them.

9. How many rows and columns does the Landsat image L7_Aug20_W84 have? What is the cell size?

10. What is the name of the northernmost volcano in Oregon?

Challenge Problem
Search the Geography Network for three different feature services that cover the same geographic area of your choice. Download and save the data, and use it to create a map. Place the map in a Word document, and include references for the data sets (providers, dates, etc.).

**TIP:** Pressing the keys Alt-PrintScr will capture a copy of the active window to the Clipboard. You can then paste it into a Word or PowerPoint document.
Skills Reference

NOTE: All skills in this chapter are used with ArcCatalog, rather than ArcMap.

Starting ArcMap or ArcCatalog .................................................. 57
Starting ArcToolbox ............................................................... 57
Connecting and disconnecting from folders ........................... 58
Connecting to an Internet service .......................................... 58
Setting options ....................................................................... 58
Viewing the contents of a folder .............................................. 59
Creating and viewing thumbnails ............................................. 59
Previewing a layer ................................................................. 59
Previewing a table .................................................................. 59
Using layer properties ........................................................... 61
Searching for data ................................................................. 61
Drag and drop files to ArcMap ............................................... 63
Viewing metadata ................................................................. 63
Creating and deleting files ...................................................... 63

Starting ArcMap or ArcCatalog

1. Look on the computer desktop for an icon named ArcMap or ArcCatalog (Fig. 1.36). Double-click it to start the program.

2. If no icon is present on the desktop, click the Start button on the computer’s menu bar. Navigate to Programs > ArcGIS and choose the name of the program desired.

3. From ArcCatalog, launch ArcMap by clicking the ArcMap button in the menu bar.

4. From ArcMap, launch ArcCatalog by clicking the appropriate icon in the menu bar.

Starting ArcToolbox

ArcToolbox is a dockable window that sits inside ArcCatalog or ArcMap.

1. Click on the ArcToolbox icon in either ArcCatalog or ArcMap to open the window.
Connecting and disconnecting from folders

In order to access data files from ArcCatalog, you must set up a connection to the appropriate disk or folder. This saves time when frequently accessing data in a subfolder deep below the top. You can set up connections either to a drive letter such as D:\ or to a subfolder in the drive. Connections can be deleted when they are no longer in use.

1. To connect to a folder, click on the Folder Connect button in ArcCatalog.

2. Navigate down the directory tree to the folder to connect to.

3. Highlight the folder (or drive letter) and click OK (Fig. 1.37).

4. To disconnect from a folder, click the connection in ArcCatalog to highlight it, and then click the Disconnect Folder button.

Connecting to an Internet service

Using ArcCatalog, you can connect to and access data from Internet Map Servers. You must know the URL of the service, such as www.geographynetwork.com. Secure services also require a login and password. ArcGIS Servers are similar to ArcIMS servers, but may serve data either over a local network or over the Internet.

1. In the left side of ArcCatalog, scroll to the bottom and expand the GIS Servers entry. Double-click the Add ArcIMS Server entry.

2. Type in the URL of the service in the top box.

3. If the server requires a user login and password, enter these at the bottom of the window, and click OK.

Setting options

You can control the way the ArcCatalog performs various actions, displays information, and so on using this dialog box. You can also set defaults for the way tables, images, and other features are displayed.

1. Click Tools in the ArcCatalog menu bar and choose Options.

2. Click the appropriate tab to set the options.

3. When done setting options, click OK.
**Viewing the contents of a folder**

1. Click on the folder in the tree window.

2. Click on the Contents tab in the content window.

3. Choose one of the display options from the toolbar: Large icons, List, Details, or Thumbnails (Fig. 1.38).

**Creating and viewing thumbnails**

1. Make sure that the layer is highlighted in the tree window and the Preview tab is clicked.

2. If desired, use the Zoom and Pan buttons to modify the appearance of the layer.

3. Click the Thumbnail button in the Zoom/Pan menu.

4. To view all the thumbnails in a folder, click on the folder, make sure the Contents tab is clicked, and choose the Thumbnail display option.

5. To view the thumbnail for a single layer, click on the layer in the tree window to highlight it and make sure the Contents tab is clicked.

**Previewing a layer**

1. Click on the data layer to highlight it in the tree window.

2. Click the Preview tab (Fig. 1.39).

3. Choose Geography from the drop-down menu at the bottom of the Preview window to preview the spatial data, or Table to preview the table.

4. Use the Zoom, Pan, Full Extent, or Identify buttons to explore the geography preview.

**Previewing a table**

ArcCatalog has many tools to investigate the contents of a table. The table can be an attribute table of a layer or a standalone table.

1. Click on a data layer or table in the tree window, and make sure that the Preview tab is clicked.

2. Choose Table from the drop-down box at the bottom of the Preview window.
Chapter 1

Sorting the table

3. Right-click the field name and choose Sort Ascending or Sort Descending from the context menu.

Getting statistics on a field

4. To get statistics for a numeric field, right-click on the field name and choose Statistics.

Freezing/unfreezing columns

5. To hold a field at the left side of the table while you scroll to the right, right-click the field and choose Freeze/Unfreeze from the context menu.

6. The field will move to the left edge of the table and remain there as you scroll to the right. More than one field can be frozen at a time.

Finding text in a field

7. To find text or values in a particular field, click on the field name to highlight the field (Fig. 1.40).

8. Shift-click to add additional highlighted fields to search, if desired.

9. Click the Options button in the lower right of the table, and choose Find from the menu. (If needed, enlarge the ArcCatalog window to the right to find the Options button.)

10. Type in the text to find. Modify the search settings if desired, and click Find Next.

Fig. 1.40. Finding text

Adding/deleting fields from Preview mode

11. To add a field, click on the Options button and choose Add Field. Enter the table name and field type. For more information on adding fields to tables, see Chapter 5.

12. To delete a field, right-click on the field name and choose Delete Field. This action cannot be undone.
Using layer properties

Data sets, including layers and tables, have properties that can be modified in ArcCatalog. The types of properties will vary with the type of data set.

1. To access the layer/table properties, right-click on the layer/table name in the tree window and choose Properties. Double-clicking the layer/table also opens its Properties.

2. Click the tab containing the properties to change.

**Shapefile** tabs include: General, XY Coordinate System, Fields, and Indexes.

**Geodatabase** tabs for feature classes include: General, Fields, XY Coordinate System, Resolution, Tolerance, Domain, Indexes, Subtypes, and Relationships.

**Coverage** tabs include: General, Projection, Tics and Extent, and Tolerances.

Subsequent chapters will describe some of these properties and how to set them.

Searching for data

The search engine in ArcCatalog locates data sets on a particular disk or server that cover the geographic area specified. The results are written to a catalog entry and can be easily dragged into ArcMap or copied to a different directory.

**TIP:** The Search option uses the file metadata, and it may fail to find files if the metadata are missing or incomplete.

1. Click the Search button in ArcCatalog.

2. Click the **Name & location** tab (Fig. 1.41).

3. To search for particular types of files, choose them from the Type list. Use Ctrl-click to select more than one. To search for all types, don't select any, or click Clear.

4. Choose Catalog to search only the connected folders, or Disk to search the entire disk.

5. Set the disk or other location to search.

6. Click the **Geography** tab.

7. If you know the map coordinates to search, type these directly into the boxes.

8. OR, to locate an area to search on a map, use the Map drop-down box at the bottom of the Geography tab to choose a display map to search on. Use one of the default maps, or select a different one from the disk by entering <Other>.

9. OR, use the buttons to zoom into the appropriate region and draw a box around the target area.
10. OR, select a place name from the list at the top of the tab. The list will depend on the map chosen in step 8. Thus, to search for a county, choose US Counties as the map layer.

11. Choose to search for data entirely within your location, or overlapping your location.

12. To search for data for specific dates, click the Date tab. Fill out the information.

13. You can also search for explicit fields and values in the metadata by clicking the Advanced tab. This option is only recommended for experienced users. However, you can use it to find data produced by certain agencies or having certain keywords. There are many ways to refine a search.

14. In the Geography tab, type in a name to save the search under, or use the default, My Search.

15. When ready, click Find Now. Wait, as the search may take some time to complete. The status bar at the bottom of the window shows the folders being searched. Click the Stop button at any time to quit the search.

16. When the search is complete, click on My Search (or whatever you named it) in the ArcCatalog tree window to expand it and view the results.

17. The Search routine places links to the original data inside the My Search entry. You can preview the geography and tables of these links just as you would other files and drag and drop them into ArcMap.

![Fig. 1.41. Searching for geographic data](image)
**Drag and drop files to ArcMap**

After searching through data in ArcCatalog, you can easily drag them into ArcMap for use.

1. Position the ArcCatalog and ArcMap windows so that both are visible.

2. Click the file in ArcCatalog that you want to open in ArcMap. Hold down the mouse button and drag it into the ArcMap window (you must be in the map window or the Table of Contents—not on a menu bar). Release the mouse click to drop the file in.

**TIP:** If ArcMap is not visible on the screen, drag the file onto the ArcMap icon on the computer’s Start Menu bar. Hold it there for a moment until ArcMap opens, and then drag the file into ArcMap.

**Viewing metadata**

1. Click on the file you wish to view and click the Metadata tab.

2. Optionally, you can change the way the metadata look by choosing a different stylesheet from the drop-down menu. They are all based on the same metadata file, written in XML; they just present the information differently.

**Creating and deleting files**

Create new shapefiles and geodatabases in ArcCatalog.

1. Click on the folder to contain the new file.

2. Choose File > New > and the type of file to create (Fig. 1.42).

3. Follow the instructions in the menu for creating the file. Different file types require different parameters.

4. To delete a file, right-click it and choose Delete. Click Yes to confirm that it should be deleted.

Fig. 1.42. Creating a file